CHAPTER 1  New Features in DP 10

Digital Performer version 10 introduces the following major enhancements. Page numbers refer to the Digital Performer User Guide unless otherwise noted.

Clips window ........................................ page 287
The Clips window is a dynamic, interactive environment for triggering audio and MIDI clips during live performance. You can prepare any number of MIDI and audio clips and then individually trigger them during playback. The Clip Editor lets you view, edit and create clips.

Audio stretch edit layer ................. page 149 & page 692
Both the Sequence Editor and Waveform Editor have a new Stretch edit layer that allows you to grab audio beats and stretch them earlier or later in time to modify their timing.

Beat Detection Engine 2.0 ............... page 681
DP’s Beat Detection Engine has been re-engineered to make beat and tempo operations on rhythmic audio easier than ever.

Enhanced Waveform Editor ............... page 525
The Waveform Editor has been greatly enhanced and streamlined.

Content Browser .............................. page 55
The new Content Browser gives you immediate access to assets that you can quickly drag and drop into your Digital Performer project, such as audio files, loops, plug-ins, virtual instruments and clippings.

VCA tracks ........................................ page 163
Modeled after classic analog consoles, VCA tracks allow you to control the relative level of any number of tracks from a single fader. With complete flexibility, you can control VCA tracks with other VCA tracks, creating nested sub-groups. Mix automation is maintained throughout, even for sub-grouped faders.

VST3 support ................................. page 900
VST3 plug-ins and virtual instruments are now supported in Digital Performer.

MOTU Instruments soundbank .......... Plug-ins Guide
DP10 includes a 5.5 GB library of multi-sample instruments, synths, loops and phrases, including over 300 different instruments, 1100 instrument presets and 500 loops. Categories include acoustic and electronic drum kits, pianos, guitars and basses, along with church organs, electric organs, strings, brass, woodwinds, synths, ethnic instruments, choirs, voices, percussion, sound effects and more. For more information, go to the Help menu in Digital Performer and choose Digital Performer Plug-ins Guide.

User interface scaling ..................... page 96
You can now scale Digital Performer’s entire user interface, including all windows and text, larger and smaller. This is especially useful on today’s high-resolution Retina displays.

Run command window .................. page 107
Type shift-space bar (or choose Setup menu > Run Command…) to open the Run Command window, which provides a command-line style interface for quick access to commands. Essentially, it’s like Spotlight (in macOS) or Windows Search (in the Start menu) for commands. Several preferences are also provided (page 80).

Enhanced Quantize .......................... page 604
The Quantize command now offers the option to move MIDI controller data along with its associated MIDI note when it is being quantized.
This allows you to preserve the timing between the note and any controller data affecting it. A separate option provides the same functionality for plug-in automation data for soundbites when they are being quantized, or even beats within soundbites.

**Enhanced Groove Quantize** ..................... page 611
The Groove Quantize command now offers the same option as above for moving MIDI controller data and audio automation along with its associated MIDI notes and audio beats to help preserve the timing between them.

**Alternate Tool** ............................... page 217
The new **Alternate Tool** can be chosen in the Control Panel and invoked using the semicolon key (or any customized keystroke), allowing you to switch quickly between the primary tool and alternate tool without repeated trips to the Tool palette.

**Absolute vs. relative grid snapping** .............. page 357
Now, by default, **Snap to Grid** (in the Snap Information window) snaps data to the absolute time line grid. There is a new **Snap Relative** check box option that snaps data relative to its original position with respect to the absolute grid.

**Auto Snap to Grid** ............................. page 355
Snap to Grid now has two modes: **Fixed** and **Auto**. In Fixed mode, you can specify the grid size, as usual. In Auto mode, DP chooses an appropriate grid size based on the zoom level of the edit window you are working in.

**Incremental transport cuing** ................. page 96
In Digital Performer’s main transport controls, the cuing buttons (fast/slow forward and rewind) can now be configured to cue in fixed increments in any time format. For example, you can program the slow forward/rewind buttons to cue by one measure and the fast forward/rewind buttons to cue by four measures. You can also cue by any number of beats, ticks, frames and seconds.

**Region command presets** ...................... page 593
You can now create and save presets for Region menu commands such as Quantize, Transpose, Change Duration and Split Notes.

**Event list “quick” filter** ...................... page 439
The event list now displays a “quick filter” section at the top of the list to easily hide types of data temporarily.

**Effects inserts in the Sequence Editor** ........ page 387
The Sequence Editor now displays effects inserts in an expandable panel to the right of the track settings panel.

**Enhanced track reordering** ..................... page 180
You can now select multiple tracks in the Track list (even a non-contiguous selection of tracks) and then drag them together as a group up or down in the Track list to move them all to the destination location in one step.

**Changing data icon colors in the Legend** ....... page 344
You can now change MIDI CC and other MIDI data colors in the Legend window by clicking the icon in the Icon column.

**Overdub recording of MIDI CC data** .......... page 248
When overdub recording MIDI continuous controller data, existing data in the track is now replaced by new data according to the track’s automation mode setting (Touch, Latch, etc.).

**Enhanced track data clippings** ............... page 707
Clippings that consist of track data can be dragged and dropped into the Track List, Track Overview and Sequence Editor. When doing so, you can now simultaneously create new tracks and drop at a specific location on the time line, in one operation. In addition, any busing between
multiple tracks within the clipping is preserved. There is a new preference for handling bussing within a multi-track clipping.

**Consolidated zoom menus** .................................. page 332
The zoom menus in the Sequence Editor, Drum Editor, MIDI Editor and Waveform Editor have been consolidated into a single menu item in the main menu bar (View > Zoom).

**New zoom commands** .......................... page 332
Several new Zoom commands have been added: **Zoom to Selected Time Range**, **Zoom to Track** and **Auto Zoom Track**, which keeps MIDI notes visible within their lanes in the Sequence Editor at all times.

**Zooming with the scroll wheel and track pad** .... page 331
If you have a scroll wheel mouse, hold Option/Alt to zoom in and out with the scroll wheel at the current cursor position. If you have a track pad, use standard pinch gestures to zoom in and out.

**Enhanced soundbite dragging** .................. page 390
When dragging soundbites in the Sequence Editor to move them, Digital Performer now displays their complete waveform while dragging to make it easier to align the waveform with surrounding tracks. In addition, a new information tab appears while dragging to convey metrics such as the new position, offset, start time and end time.

**New MIDI note display preferences** .............. page 92
There are several new preferences for the way MIDI notes can be displayed in the Graphic Editor note grid. For example, you can display the MIDI note number and on-velocity bar inside the note. You can also choose to display MIDI notes with square corners, instead of round corners, which speeds up redrawing considerably.

**Canceling while dragging** .................. page 334
You can now cancel in the middle of a dragging operation by pressing the escape key.

**Cell focus** .................................................. page 116
When a cell in the Consolidated Window becomes the focused cell (by clicking its title bar), it now displays a light blue border around the outside edges of the cell, to more clearly indicate that the cell has the focus.

**Bite Gain fader** .......................... page 393
When audio tracks are resized vertically in the Sequence Editor, and expanded far enough, each soundbite displays its **Bite Gain** setting and fader in the bottom left corner.

**Playback wiper snaps to grid** .............. page 229
When you drag the playback wiper, it now respects grid snapping, if enabled.

**Audio metering is post-pan** ........................ page 94
Audio meters can now be configured as either pre- or post-pan.

**Chunks can now be color-coded** ............. page 793
There is a new column in the Chunks window that lets you assign a color to each chunk using the standard color picker.

**Duplicate command** ........................ page 582
The new **Duplicate** command lets you quickly repeat the currently selected time range or object, such as a MIDI note, soundbite or clip.

**DP plug-ins now reside in the app** ........ page 899
Digital Performer’s included MAS plug-ins and virtual instruments are now stored inside the Digital Performer application bundle. This ensures that they will always be version-compatible with the version of DP that you are running.

**Velocity tool** ........................ page 354
The **Velocity tool** allows you to click on a MIDI note and drag up or down to adjust its velocity. You can also swipe horizontally in the continuous
data grid in the MIDI Editor or the note velocity
lane in the Sequence Editor to adjust multiple note
velocities in a single gesture.

**Hand tool ................................................. page 354**

The **Hand tool** allows you to scroll graphic editors
smoothly and precisely. It also lets you scroll
vertically and horizontally in a single gesture.
Simply click anywhere in the graphic editor grid
and drag as desired.

**Enhanced editing of audio automation ............. page 226**

When the **Interpolate chased automation events
when editing** option is enabled, copying audio
track data selections will generate and place ramp-
style automation events at the selection
boundaries and include them when pasting,
merging, splicing, or shifting the clipboard data.
This preserves automation settings before, after
and within the region being edited.

**Memory Cycle and Auto Record strips .......... page 207**

In the Sequence Editor, MIDI Editor and other
graphic editors, The Memory Cycle strip (just
below the time ruler) displays the Memory Cycle
loop as a colored bar. Drag in the strip to enable
Memory Cycle and set the start and end times.
Drag the endpoints of the bar to change them, or
drag the bar to move it. Click the bar to toggle
Memory Cycle on or off. This same behavior
applies to the Auto Record strip just below the
Memory Cycle strip.

**Enhanced note velocity display ............... page 426**

MIDI note-on and note-off velocities are now
displayed with larger icons for enhanced viewing
and editing in graphic editors.

**MIDI note-on velocity tails (duration) .......... page 426**

MIDI note-on velocities are now displayed with
tail that indicates the note duration. This new
option can be shown or hidden with a preference.

**Zooming gestures..................................... page 331**

You can now use pinching gestures on your
laptop’s track pad to zoom graphic editors, both
vertically and horizontally. You can also now use
the scroll wheel on your mouse for zooming by
holding down the Option/Alt key.

**Audition volume................................. page 95**

There is a new preference for adjusting the volume
when using Audible mode and the many other
auditioning features (in the Commands window).

**Bounce to Disk enhancements ................. page 953**

You can now choose to bounce in real time or
faster than real time (with the Offline bounce
option). The new **Bounce Includes Audio Patch
Thru** option allows you to include monitored
inputs (from VI’s or live external sources, for
example) while bouncing, either in real-time or
offline. You can now bounce multiple files (stems)
in a single operation. You can now choose to
bounce tracks, outputs or both during a single
bounce operation. When bouncing tracks, you
have the option of matching the channel format of
the track or the track’s output (for example, a
mono track assigned to a stereo output).

**Enhanced marquee selection of MIDI notes ..... page 92**

There is a new preference that governs marquee
selection of MIDI notes in graphic editors. This
preference lets you control whether notes are
selected if either a) **the start of the note** is within
the marquee selection or b) **any portion of the note**
is within the marquee selection.

**Recording into clip cells .......................... page 292**

You can now record into clip cells in the Clips
window (into new, empty cells or into existing
clips).

**Clip Record mode ............................. page 297**

Option/Alt-click the Record button in the main
Control Panel to toggle between Record mode and
Clip Record mode. In Clip Record mode, all clips
triggered in the Clips window are recorded into their respective tracks as clips, allowing you to capture your performance for future playback and editing.

**Clips in tracks** .......................................................... page 400
You can now put clips in tracks so they play at the desired time without having to queue them manually in the Clips window. Edit clips in tracks with all of the same methods you’re accustomed to when editing soundbites: split, trim, drag and drop, edge edit, copy/paste and more.

**Clips replace loops** ....................................................... page 402
Loops from previous versions of Digital Performer are converted to looped clips when opened in version 10.1. The clip will be looped as many times as the original loop.

**Enhanced layering commands** .............................. page 587
The Layering commands have been moved from the Audio menu to the Edit menu. They now apply to both soundbites (in audio tracks) and clips (in both audio and MIDI tracks).

**Retrospective MIDI Record** ................................. page 283
Digital Performer is always capturing MIDI input, even when its main transports are not actually recording — or even completely stopped. As a result, you can immediately recall material you’ve recently played at any time. Use *Retrospective MIDI Record* (Region menu) to place captured MIDI input into a track.

**Model12 enhancements** .... Model 12(Plug-in Guide) 113
Model12 has been enhanced with new presets, kits and samples.